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1.0 ABSTRACT
My research this semester involved designing a 30x30 cm zigzag readout board. The goal was to create the board so we can test the efficiency of the zigzag traces on a readout board as opposed to regular straight traces. 
The general board was divided into three sections, where the zigzags are oriented in three different ways. The zigzags’ dimensions were based off of previous designs and the 10x10 cm readout board currently in the lab. 
At the beginning of the semester, the schematic sheets for the first section of the board had been finished - but the zigzags for that section, the other schematic sheets, and components had not been placed on the board. Now, the schematic sheets for the three sections are complete; the board has the zigzags for the first two sections are finished; the mounting holes for the gas frame are in place; finally, the Panasonics are in place on the board. The net mapping for the first two sections is still in progress.
The next step is to finish the net mapping for the first two sections. After that, the zigzags for the third section will need to be constructed and the nets connected. The last thing that needs to be completed is a ground plane for the pins that are not connected to the zigzag traces. 
2.0 BOARD DESIGN
The design of the board was based off of the 10x10 cm zigzag readout board that is already in use. During the course of the semester it was decided that two boards would be designed; one for the fine zigzags and one for the course zigzags. The two boards will be otherwise identical. The board discussed in this report is the board for the fine zigzags.
2.1 The Overall Board

The final board will have three Panasonic connectors, a 30x30 cm zigzag readout, and twenty eight mounting holes for the gas frame. Below is a sketch of what the general idea of the final board will look like.
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	Figure 1: General Sketch of Final Board (Very Rough Draft)


The board has been divided into three sections. The first section parallels the 10x10 cm board it was based upon. It has one Panasonic with one hundred and thirty pins, one hundred and twenty eight of those are connected to zigzag traces and the last two are grounded. The zigzags are all in the same direction perpendicular to the Panasonic. 

The second section of the board uses the same type of Panasonic connector, but only forty one of it pins are connected to zigzags traces while the others are grounded. These zigzags are also all in the same direction perpendicular to the Panasonic. 
The third section also uses the same type of Panasonic as the other two sections. This configuration uses sixty four of the pins to connect to zigzag traces while the others are grounded. The zigzags in this section are divided into two “groups”. Each group of zigzags is set at a different angle radially outward from the Panasonic. 

2.2 The Zigzags

As stated above, the boards will only have one size of zigzag, either course or fine. Below is a figure of the dimensions used for the zigzags. Due to limitations of the PCB Editor in Altium, the zigzags are not exactly these dimensions. 
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	Figure 2: Zigzag Dimensions

The diagram to the left displays the dimensions the zigzags were based on. As shown, the set used was under “Marcus”. The image on the right shows the zigzags and their dimensions as they are on the board.


3.0 PROGRESS
At the beginning of the semester, the schematic sheets for the first section of the board had been finished - but the zigzags for that section, the other schematic sheets, and components had not been placed on the board. Now, the schematic sheets for the three sections are complete; the board has the zigzags for the first two sections are finished; the mounting holes for the gas frame are in place; finally, the Panasonics are in place on the board. The net mapping for the first two sections is still in progress.
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	Figure 3: The Board As It Stands Now


	[image: image6.png]




	Figure 4: The New Connector & Nets Before Routing


The most challenging part of the board was the net mapping. Originally it was believed that the nets created on the schematic sheets would automatically route the traces around objects to connect the pads and pins. However, this was definitely not the case. Eventually it was discovered that the thin lines representing the connection between the pins and the pads could be manipulated using the “Interactive Routing” tool. After discovering it was possible to change the angle settings on the trace, routing the traces became significantly easier. Unfortunately, each of the nets have to be routed individually, which made the task time-consuming and tedious. 
Another challenging part in designing the board involved drawing the zigzags. Since the zigzags were to act like traces, it was thought that it would be possible to draw them using the “line” (trace) tool. However, the freedom to adjust the traces was very limited and it was not possible to create the zigzags required.  After using the Altium forums it was determined that using the solid region feature would be the most effective way to draw the zigzags. The tool took some adjustment, but I was able to make the zigzags within the desired dimensions by setting up several dimension labels, according to the chart in Section 2.2, and fitting the solid region inside those dimensions (see Figure 2). After completing the first two sections of the zigzags it was determined that the outside edges of the zigzags needed “end caps” – something to more cleanly determine the edge and hopefully decrease noise. More details about the dimension labels and solid regions are in Section 4.5.2 and Section 4.5.4. Below you will see several close-ups of the area where the first section ends and the second begins. You can see how the end caps “clean up” the edges of the overall zigzag regions.
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	Figure 5: The Region Between Section 1 & 2

The image on the left is a closer view of the zigzags between the first and second sections. The image on the right shows an even closer view, including how the solid regions for the second section were arranged.


Many of the current dimensions of the zigzags were determined from trial and error, particularly for the first section of the board. The zigzags had been constructed according to the chart mentioned above. However, once one hundred and twenty eight of the traces had been put together, they were far too large for the board. The pitch of the zigzags, the space in between them, and the thickness of the zigzags were all changed at some point to try to fit the zigzags into the proper space. After six trials the closest configuration of zigzags to fit the 30x30 cm space, without straying too far from the original design, was only four millimeters over. It is believed that this will not cause problems with the gas frame. 
The next step is to finish the net mapping for the first two sections. After that, the zigzags for the third section will need to be constructed and the nets connected. The last thing that needs to be completed is a ground plane for the pins that are not connected to the zigzag traces.
4.0 BOARD CREATION
Described below are some of the basic functions of Altium Designer Release 10 and how to use them.
4.1 Licensing
In order to use Altium, you must be logged into the Graviton computer in the lab as the Administrator. The log-in information is below:



Username: Administrator



Password: deleted in this public version (ask Dr. Hohlmann if you need it)
Also note that the “M-HEP (this computer)” option on the drop-down menu below these fields is selected.

Once you open Altium for the first time you will be faced with a home screen called “My Account”. A sign in link will be located just below the “My Account” title on the left side of the screen. The log-in information is below:
User name: deleted in this public version (ask Dr. Hohlmann if you need it)
Password:     - ditto -
You have the option to remember the sign-in information if desired. After signing in you will see a list of available licenses. Click on the top On-Demand license with the activation code B6TJ-EXPU (valid until March 29th, 2014), then click “Use” on the left column below the license options. This allows you to access the current license and use the full potential of the program. After this is done it will not need to be done again unless you sign out of the program. Please note that this license only has one seat available. This means that you cannot have multiple computers, or users, logged in to the account at a time.
4.2 Creating a project
On the home screen (“My Account”) page you will see several options for opening documents, projects etc. in the drop box column to the left labeled “Files”. To create a new project you can either select “Blank Project (PCB)” from the “New” drop box section in the aforementioned column, or click on the “File” tab on the top toolbar and select New>>Project>>PCB Project. You can rename the project by using the right click button on the mouse.
If you have already created a project and wish to continue working on it, you can select your project from the “Open a project” drop box in the “Files” column. You could also go to the bottom of the “Files” column where you will see a tab labeled “Projects”. Once you click on this it will show the “Projects” column, where any projects that have been worked on recently will be shown. Double-clicking on any of the items in this column will open the document to the right. You can have several documents open at a time, as a toolbar will appear above them listing all of the open documents. It is also possible to open documents in separate windows.
4.3 Libraries

To add a new schematic library, right-click on the project name and go to Add New to Project>>Schematic Library. For this particular project, a new schematic library is not necessary. To add an already existing library, right-click the project name and go to Add Existing to Project…. The program will then open a new window and ask you to choose the library you want to add. Once you add a schematic library, new or existing, a folder will appear under the project name called “Libraries”. A subfolder will appear under that labeled “Schematic Library Documents”, which is where the schematic library will be stored. The schematic library used for this project is called ‘GEM_HOHLMANN (6)_Library.SchLib’.
Adding a new or an existing PCB library is the same as adding the schematic libraries. Once you add a PCB library, new or existing, another subfolder will appear under the “Libraries” folder called “PCB Library Documents”, which is where the PCB library will be stored. The PCB library used for this project is called ‘30x30 4.15.13.PcbLib’. Both the schematic and PCB libraries can be found in the folder labeled “Hohlmann” on the desktop of the Graviton computer in the lab. 
4.4 Schematics
To add a new schematic sheet to a project, right-click the project title and go to Add New to Project>>Schematic. A folder will appear under the project name called “Source Documents”. This is where all of the schematic sheets and PCB documents will be saved for the project. For this project there are six schematics sheets, which can also be found in the “Hohlmann” folder. To add the existing documents, follow the same procedure as the libraries. A couple examples of schematic sheets are shown below.
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	Figure 6: Schematic Sheet Examples from Board Design


4.4.1 Adding Components

To add a component to a schematic sheet, simply open the “Place” tab on the top toolbar and select Part. A window will open called “Place Part”. Next to the drop-down menu labeled “Physical Component”, click on the button Choose. This will open another window with a list of parts and a drop-down menu of all of the available libraries. Find the library you need for the part and select the part. The window will automatically close and the part will appear at the end of the mouse arrow. Position the part where you wish and click to place it. The program will continue to supply you with the part selected until you right-click to exit the application, allowing you to place as many as you need all at the same time.
It is also possible to add a component to the board by right-clicking on the schematic sheet itself, selecting Place>>Part…, and then following the steps listed above. 
4.4.2 Editing Components
Editing the designators of the components is most of what the editing in the schematic sheets is. It is important not to have two components with the same name or you will have compilation errors. For this project, the main components, such as the Panasonic and the pads for the zigzags, are designated with “J” and then a number.  The pins of the components are labeled with numbers only. Finally, the nets are labeled using “SIG_” and a number. To edit these designators, simply double-click on them to get their property menus. 

4.4.3 Nets and Ports
Nets are used for connections between schematic sheets. For example, the schematics for the Panasonics are on a separate sheet to the pads for the zigzags. However, these two things must be connected when imported to the PCB Editor – which is where the nets come in. Ports are used for connections made on the same schematic sheet. For example, if the Panasonic and the zigzag pads were on only one sheet. Therefore, for this project, only nets are used. 
To place a net, click on the blue icon that says “Net” on the toolbar just above the sheet. A cross will appear over the end of the mouse arrow with the text “Net Label 1”. Place the net on a wire connected to the desired pin, the cross will turn red when it is connected. Once the net is placed, the cross will appear with the text “Net Label 2”. The program will continue to supply net labels, in numerical order, until you right-click to exit the application. It is important that the net labels are the same for the two pins, or traces, you wish to connect.
4.5 PCB Editor
To add a new PCB document, right-click the project title and go to Add New to Project>>PCB. To import your schematic designs to the PCB board go to the “Design” tab at the top toolbar and select Import changes from [project name].  (It is also possible to update the schematic sheets from the PCB design.)
4.5.1 Board Size & Shape

The easiest way to determine the board size and shape is to use “lines”. Go to the “Place” tab on the top toolbar and click on “Line”. A cross will appear on the mouse arrow. For this board we want a square, so it would be easier to draw one straight line of the correct length and copy it three times. Once the lines are in place, highlight the square and then go to the “Design” tab and choose Board Shape>>Define from selected objects. The board, represented by a black box, will then size itself to the lines. You can then delete the lines and just use the new board outline. 
4.5.2 Measuring Distances

There are two basic ways to measure distances in the PCB Editor. The first method is used for marking distances, or linear dimensions, between objects. Click on the icon with the ruler and blue “L” shaped line. A table of different dimension label styles will appear. The most common style is the icon on the top left corner, with the blue lines and number 10 on it (shown below). A green bar will appear on the end of the mouse arrow. Click on the beginning object, or location, and then the second to “end” the label. Right-click to exit the application. The label will be in mils to begin with; to change it to millimeters you can double-click on the bar which will open the properties window for the label, where there will be a dropdown menu for the different units. 
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	Figure 7: Measuring Distances using “Place Linear Dimension”
The image to the left shows where the icon for this function can be found. It also shows the other types of dimensions that can measured this way. The image to the right shows what the dimensions look like before and after use.


The second method is for quick measurements, not displaying dimensions. To do this, click on the “Reports” tab on the top toolbar and go to Measure Distance. A cross will appear on the mouse arrow. In order to measure the distance, click on the beginning object, or location, and then the ending location – a small window will then appear with the distance. Right-click to exit the application. 
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	Figure 8: Measuring Distances
The image to the left shows where this function can be found. The image on the right shows what it looks like in use.


4.5.3 Editing Components

Most of the editing that would need to be done is rotating components. This is done by clicking on the component and then going to the “Edit” tab on the top toolbar, then going to Move>>Rotate Selection. A small window will appear asking for how much you wish to rotate the object. 
4.5.4 Creating the Zigzags

The zigzags are created using solid regions. A solid region is created by selecting the “Place” tab on the top toolbar and choosing Solid Region. A cross will appear at the end of the mouse arrow. To draw the shape you want using this tool will take some adjustment, as you do not draw one side at a time. The solid region tool starts with all ends, or sides, connected – resembling a triangle. The images below help to show what I have described. 
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	Figure 9: Solid Regions
The image on the left shows where the solid region function can be found. The image on the right shows how the solid region works while in use. As mentioned above, all sides are connected while drawing the region.


The zigzags were made by making one half of a zigzag, then copying and mirroring it and piecing them together. This piece was then copied and pasted onto the previous zigzag until the full length of the zigzag strip was complete, as shown below. Once the solid region has been drawn it is possible to change its shape, which makes for easier adjustments. 
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	Figure 10: Making the Zigzags
The image above shows the steps of how the zigzags were made. A solid region was made (left). This region was then copied, pasted and mirrored (center) and put together to make the shape shown on the right. The shape on the right was then copied and pasted onto the end of this shape etc.


The final elements of constructing the zigzags were the “end caps” and the connection to the pads. These were also created using solid regions, as shown below.
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	Figure 11: “End Caps” and Pad Connections

The image on the left is of the “end caps” created for the edges of the zigzags. The image on the right is the solid region created to connect the zigzag trace to the pad with the net connection.


4.5.5 Net Mapping

This is probably the most difficult part of editing the PCB board. Once you have placed all of the components and arranged them as you like, you can do the traces – the connections between components. In this case, the traces are between the Panasonic connector and the zigzag strips. Any nets from the schematic sheets will translate to the PCB as thin lines. To manually route the nets, which will be necessary for this project, right-click on one of the lines to get a menu and select the Interactive Routing option. A cross will appear on the end of the mouse arrow. Select the line you wish to move and move as desired. If you press the space bar while you have the line selected it changes the possible angles and orientation the trace is allowed to do. It is recommended to use the “any angle” setting. Right-click to exit the application.
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	Figure 12: Net Mapping
The image on the left shows the right-click menu where the interactive routing function can be found. The image on the right shows how the nets look while routing them.


4.6 Support Services
If you need assistance there are several “Help” options available:
· The first is called the “Altium Wiki”, which can be accessed from www.wiki.altium.com, or by clicking on the top left black and gold icon labeled “DXP” and scrolling down to the Altium Wiki button. The Altium Wiki is an encyclopedia specifically for the program that has tutorials and informational materials for Alitum. However, each version of Altium is slightly different so the tutorials are not exactly the same, but are useful overall.
· The second is the Altium forums. These can also be accessed by using the DXP icon, or by going to www.live.altium.com and signing into the page (the log in for this site is the same for the program itself). The forums work just like regular forums – where other users ask and answer questions on the Altium Live website. Altium support experts are also known to answer questions. It is recommended that you try to find the answer to your question in previously asked questions before creating a new “case”. 
· The third is the Altium Support Services “help line”. If you cannot find the answer to your question(s) using the above methods, the Altium team has people available for questions. The phone number for the support services is 1-800-488-0681. They can also be reached by email at support.na@altium.com. 
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